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1 Introducción 
 
1.1 Aplicaciones sugeridas 
 
Gracias por comprar un audiómetro Amplivox. El Amplivox PC850 es un audiómetro de 
conducción aérea para una prueba rápida que está diseñado para ser utilizado por audiólogos 
y profesionales sanitarios. Su uso principal es como audiómetro automatico (utilizando como 
interfaz y ejecutado desde el software del ordenador Amplivox Audibase). Sin embargo, 
también puede usarse como un audiómetro manual autónomo que puede guarder resultados 
de hasta 12 pruebas. Estas pruebas pueden transferirse al Audibase en una etapa posterior. 
 
El Audibase permite el almacenamiento electrónico de pruebas audiométricas en un 
ordenador, esquemas de categorización de audiogramas, impresion de audiogramas e 
intercambio de datos con otras aplicaciones del PC. 
 
El audiómetro no está destinado para determinar la magnitud y el alcance completo de la 
deficiencia auditiva del paciente. 
 
1.2 Desembalar el audiómetro 
 
Abra el paquete y extraiga cuidadosamente el equipo. Compruebe que están incluidos, junto 
con su audiómetro, todos los accesorios solicitados y detallados en la factura. Si le hiciera falta 
algún accesorio por favor contacte con su distribuidor Amplivox. 
 
Guarde el cartón y los materiales de embalaje, ya que el audiómetro requiere calibrarse cada 
año, por lo que deberá enviarlo en su empaque original. 
 
1.3 Contenido estándar 
 
Audiómetro PC850      Auriculares audiométricos 
Pulsador de respuesta del paciente   Cable de USB 
Adaptador principal, ver 2.3    Manual de instrucciones y guía 
Certificado de calibración     Bolsa de transporte 
Disco de instalación de software 
 
1.4 Accesorios opcionales 
 
Tarjetas de audiograma     Cable de USB 
Audiocups (audífonos reductores de ruido) 
 
2 Instrucciones de seguridad importantes 
 

 

El audiómetro PC850 debe utilizarse únicamente por profesionales cualificados 
para realizar pruebas audiométricas. Su finalidad es servir como herramienta de 
detección. 

 
 

2.1 Precauciones 
 
POR FAVOR LEA EL MANUAL DE INSTRUCCIONES ANTES DE USAR EL AUDIÓMETRO 
 
En cumplimiento con las normas IEC 60601-1 de seguridad y IEC 60601-1-2 de compatibilidad 
electromagnética (EMC, por sus siglas en inglés) el audiómetro está diseñado para ser 
utilizado solamente con el adaptador de corriente suministrado, que cuenta con aprobación 
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médica y que se especifica como parte de este equipo. No utilice ningún otro tipo de 
adaptador de corriente con este instrumento. Consulte la Sección 13 para conocer el 
número de stock del adaptador. 
 
El Audiómetro debe usarse únicamente en interior y solo en la forma en que se describe en 
este manual. 
 
Los transductores suministrados con el audiómetro están específicamente calibrados con éste, 
si se reemplazan será necesario calibrarlos de nuevo. 
 
No sumerja la unidad en ningún tipo de fluido. Consulte la Sección 9 de este manual para 
conocer el procedimiento de limpieza apropiado para este instrumento y sus accesorios. 
 
No utilice el instrumento en un ambiente con exceso de oxígeno o en presencia de mezclas 
anestésicas inflamables u otros agentes inflamables. 
 
Evitar que el aparato se caiga o se golpee con otro objeto, si esto sucede, envíelo al fabricante 
para que lo reparen o calibren. No usar el aparato si se sospecha que tiene algún daño. 
 
El aparato debe almacenarse y utilizarse en un lugar que reúna las características 
especificadas de temperatura, presión y humedad (ver Secciones 8 y 10). 
 
No intente abrir, alterar o reparar el instrumento. Ante cualquier necesidad de reparación o 
servicio, remita el instrumento al fabricante o distribuidor. La apertura del aparato anulará la 
garantía. 
 
2.2 Sobre la Compatibilidad Electromagnética (EMC) 
 
El equipamiento médico eléctrico necesita una precaución especial en relación al EMC y 
necesita que se instale y se ponga en funcionamiento según la información suministrada sobre 
EMC en el Anexo 1. Esta guía informa acerca del ambiente electromagnético en el que se 
debe utilizar el instrumento. 
 
Equipos portátiles y móviles de radio frecuencia pueden afectar a los equipos médicos 
eléctricos. Por tanto, el aparato no debe utilizarse de manera adyacente o almacenarse junto a 
otros equipos. Si esto fuese necesario, el audiómetro debería observarse para verificar su 
normal funcionamiento. 
 
2.3 Principales operaciones de alimentación 
 
El audiómetro está diseñado para una intensidad continua y se alimenta mediante un 
adaptador de corriente que es suministrado y que se especifica como parte del equipo. Si se 
desea reemplazarlo, por favor contacte con su distribuidor Amplivox. 
 
Todas las demás conexiones deben realizarse antes de conectar el cable de salida del 
adaptador en el enchufe marcado como POWER en la parte trasera del audiómetro. Conecte 
la fuente de corriente; tanto el indicador del adaptador como el indicador de POWER en el 
audiómetro se iluminarán en verde, mostrando que el instrumento está listo para usarse. 
 
La salida del adaptador de corriente está equipada con una protección de circuito eléctrico. En 
caso de sobrecarga el adaptador se apagará y al igual que la luz del indicador. Cuando el fallo 
se solucione, el adaptador volverá a funcionar normalmente. 
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La entrada al adaptador de corriente está protegida con un fusible no reemplazable. Si se 
produce un fallo, el adaptador no funcionará. 
 
El audiómetro debe ubicarse en un lugar accesible para conectar el adaptador de corriente 
fácilmente. 
 
2.4 Conexiones del audiómetro 
 
Todas las terminales y conexiones importantes están etiquetadas para asegurar su correcta 
identificación y conexión según la tabla que a continuación se presenta: 
 

Etiqueta del 
conector 

Tipo de 
Conector  

Código 
de 

Color  
Parte Conectada Notas 

RIGHT 
LEFT 

6.3mm jack 
6.3mm jack 

Rojo 
Azul 

Audífono de conducción de 
aire * 

 

N/A RJ12  Puerto reservado; Amplivox 
diagnóstico 

Ver abajo 

USB Conector USB  Puerto USB para PC Ver 2.5 

N/A 6 pin mini DIN  Puerto reservado; Amplivox 
diagnóstico 

Ver abajo 

POWER 2.5mm jack 
alimentación 

 Adaptador principal AC/DC * 
 

RESPONSE 6.3mm jack 
Negro 

Interruptor para respuesta 
del paciente * 

 

 

Los números de partes relevantes están indicadas en la Sección 13. 
 

Nota en relación con los conectores “6-pin mini DIN” y “RJ12”: 
Se trata de una toma restringida para el uso restringido por parte de Amplivox. 
No se permite el acceso del usuario. 

 
Las partes marcadas con * solo conectarlas con los accesorios suministrados por 
Amplivox o un distribuidor de Amplivox. Estos accesorios han sido probados para 
usarse con el audiómetro PC850 conforme al cumplimiento de los estándares 
IEC 60601-1 y IEC 60601-1-2. El uso de otros accesorios que no sean los 
especificados, pueden comprometer el cumplimiento de estas normas. Para 
otros enchufes, remitirse al Anexo 2. 

 
2.5 Conexión a un ordenador 
 
 

Consulte el Anexo 2 para obtener información importante sobre la 
conexión de equipos eléctricos no médicos a equipos eléctricos médicos 

 

 

El audiómetro se suministra con software para el ordenador (incluyendo la aplicación del 
Amplivox Audibase) el cual permite la realización de pruebas automáticas a través del 
ordenador con la transferencia de los resultados de las pruebas audiométricas para su 
almacenamiento y análisis. Debe usar el cable USB específico que se añade con esta opción. 
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3 Uso del audiómetro (general) 
 
3.1 Encendido y apagado del audiómetro 
 

Apretar y mantener pulsado brevemente el botón  (situada en el panel posterior). No se 
requiere precalentamiento previo. La pantalla mostrará el modelo y del audiómetro y el tipo de 

auriculares en uso. Para apagar, presione nuevamente el botón  o apretar y mantener 
pulsado la tecla MENU seguido de la tecla YES (RIGHT), luego suelte ambos controles 
 
3.2 Prueba del pulsador de respuesta del paciente 
 
Presione el interruptor de respuesta del paciente y la luz marcada con la palabra RESPONSE 
(encima de y a la derecha de la pantalla) se iluminará en verde. 
 
3.3 Probar la Función Talkover (hablar a través del micrófono) 
 
Usa la tecla TALKOVER para confirmar el funcionamiento de esta función. (Ver Sección 
5.2.3). 
 
3.4 Preparación de la audiometría y condiciones ambientales 
 
Para orientación sobre pruebas audiométricas, consulte los diversos estándares audiométricos 
y otras publicaciones relevantes. 
 
Las pruebas audiométricas deben realizarse siempre en condiciones silenciosas (por ejemplo 
una habitación silenciosa o una cabina acústica). Los audífonos reductores de ruido 
opcionales (Audiocups) pueden brindar una aislación adicional del ruido ambiente. Para más 
explicaciones sobre los niveles de ruido ambiente permisibles, consulte la norma de 
audiometría ISO 6189. 
 
3.5 Disposición del sistema de prueba 
 
El esquema presentado a continuación muestra un ejemplo típico del uso del equipo para 
pruebas audiométricas. El audiómetro se ubica sobre la mesa frente a un operador que está 
sentado. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
El paciente se sienta frente a la mesa, de espaldas al operador. Utiliza auriculares o un 
transductor apropiado (ver Sección 3.6) y responde a los estímulos de prueba utilizando un 
interruptor de mano que también está conectado al instrumento. 
 

Operador 

  Audiómetro 

Ordenador 

Paciente, utilizando auriculares 

 Cables de auriculares 

Interruptor de respuesta y cables 
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3.6 Auriculares 
 
Los auriculares o transductor apropiado deben colocarse por una persona cualificada, para 
asegurar que queden correctamente sellados y permitan un ajuste cómodo. Se conectan los 
cables de los auriculares al instrumento y luego los auriculares se le ponen al paciente.  
 
4 Uso del audiómetro (pruebas automáticas) 
 
4.1 Introducción 
 

Antes de que el PC850 se use como un audiómetro automatico, el software de 
funcionamiento y la aplicación de Audibase deben instalarse y registrarse al ordenador 
conectado. Ver la Sección relevante del manual de funcionamiento de Audibase para más 
detalles sobre esta operación. 
 
Al iniciarse el aparato, la pantalla muestra las siguientes opciones por defecto: 
 
SIGNAL dBHL     FREQUENCY Hz 

 30dB                            1kHz 

 < >           < >       

 
Esto indica que del audiómetro ya está disponible para utilizarse para la prueba automática 
que es iniciada por el Audibase y controlada por el software PC850 
 
4.2 Tipos de pruebas disponibles 
 
4.2.1 Prueba de ordenador (Computer) 
 
Se trata de una forma de audiometría automatic basada en el método de Hughson y Westlake 
que la inicia automáticamente el instrument. El nivel se incrementa en pasos de 5dB hasta que 
se obtiene una respuesta del paciente y disminuye en 10 dB hasta que no se produzca 
ninguna respuesta. El proceso se repite hasta, dependiendo del criterio seleccionado para 
grabar un umbral (ver Sección 4.4), el instrument grabará un umbral a una frecuencia 
determinada. El PC850 continuará con la siguiente frecuencia de prueba y se completará la 
prueba en ambos oídos. Cuando se haya completado, los datos de la prueba se transfieren al 
Audibase. 
 
4.2.2 Prueba Bekesy  
 
Método de audiometría automatic ideado por Von Bekesy (1947) que utiliza estímulos de 
tonos puros para rastrear umbrales auditivos. 
 
Esta aplicación es conocida como la prueba de frecuencia discrete de Bekesy y el principio de 
la prueba es que el paciente ajuste el nivel presentado según su umbral auditivo. El nivel del 
decibelios desciende cuando el paciente presiona el interruptor de respuesta tras oir el tono 
presentado. En cambio, cuando el paciente ya no puede oír el tono presentado, liberará el 
interruptor, permitiendo después aumentar el nivel hasta que el tono presentado se escuche 
de nuevo. El nivel cambia en pasos de 2.5dB. 
 
Cuando un número de esos “picos” y “valles” se dan de forma consistente, el PC850 calculará 
un promedio al dB más cercano y lo mostrará como el umbral de audición para esa frecuencia 
particular. Entonces, el PC850 continua con la siguiente frecuencia de prueba y así 
sucesivamente hasta completar el test en ambos oídos 
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4.2.3 Prueba de frecuencia única 
 
El PC850 ofrece la posibilidad de repetir una prueba a una sola frecuencia especifica y añadir 
los resultados en el resultado global audiograma. Esta característica es útil para situaciones 
en las que una frecuencia particular, ha dado algún problema. 
 
4.2.4 Prueba en modo Mixto (ver lecturas sobre uso manual) 
 
Esto permite probar manualmente algunas frecuencias cuando una prueba automatica no ha 
podido determinar un umbral. La combinación de resultados se transfieren a Audibase 
 
4.2.5 Prueba manual (subida manual de las lecturas) 
 

Aunque no es estrictamente una prueba "automática ", esto permite al operador utilizar el 
software PC850 para transferir a Audibase los resultados de una prueba manual anterior. 
Estos podrían ser cualquiera del umbral retenido (véase la Sección 5.3) o los umbrales 
almacenados en una de las ubicaciones de la memoria interna del audiómetro (ver Sección 
5.4). Los datos audiométricos se transfieren a Audibase de la misma manera que una prueba 
automática. 
 
4.3 Realización de una prueba 
 
4.3.1 Preparación 
 
Para orientación sobre pruebas audiométricas, consulte los diversos estándares audiométricos 
y otras publicaciones relevantes, además, de la Sección 3 para preparar el audiómetro.  
 
4.3.2 Instrucciones al paciente 
 
Al paciente, normalmente, se le dan las siguientes explicaciones. 
 

 En el caso de prueba manual u Computer: “Tan pronto como se oiga el sonido, presione y 
libere el interruptor”. 

 En el caso de la prueba de Bekesy– “mantenga pulsado el interruptor de respuesta cuando 
se escuchen una serie de latidos, y libere cuando los latidos ya no se escuchan”. 

 
4.3.3 Empezar una prueba 
 
Antes de empezar una prueba automatica es importante borrar cualquier lectura de 
pruebas actuales del audiómetro (normalmente serían umbrales guardados de una 
prueba manual anterior- ver Sección 5.3). Ver Sección 5.2.2 para más detalles acerca de 
cómo borrar un test. Si no se borra, entonces es que habrá algún error que puede llegar 
a ser problematico. 
 
Inicie la aplicación Audibase y teniendo en cuenta el manual de usuario, cree un paciente 
nuevo o acceda y muestre detalles de un paciente existente. Haz click con el botón derecho 
del ratón en el iconco “Test” en la barra de herramientas de Audibase. 
 

 
 

Alternativamente, utiliza “Test > Launch Test” del desplegable de selección de menú en la 
parte superior de la ventana de Audibase 
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Se abrirá una ventana nueva para el software PC850 y el audiograma guardado más reciente 
en Audibase se transfiere y se muestra en la ventana PC850 como datos anteriores. 
 

 
 
4.3.4 Ejecutando una prueba 
 
El tipo de prueba usado previamente se recuerda y se muestra la siguiente pantalla de 
diálogo. 
 

 
 
4.3.4.1 Ejecutar el mismo tipo de test previo 
 
Para ejecutar el mismo tipo de test con las mismas opciones como se ha usado previamente, 
simplemente haz click en “Yes” y el test comenzará de la misma forma (ver Secciones 4.3.5 a 
4.3.9). El icono de “Run selected test” cambiará a como se muestra debajo. 
 

 
 
Suponiendo que una prueba automatica está en uso, el número de serie del audiómetro 
conectado se muestra arriba a la derecha en la ventana del PC850 y el mensaje “Running 
test” se muestra arriba a la izquierda. Además, aparecerá “Linked” en la pantalla del 
audiómetro. 
 
Para hacer el seguimiento de los tonos presentados seleccione el icono “Show test detail” 
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Alternativamente use “View > Detail” del menu despegable. 
 
Para ver los umbrales del audiograma seleccione el icono “Show Audiogram” 
 

 
 
Alternativamente use “View > Audiogram” del menu despegable. 
 
Si se establecen los umbrales a todas las frecuencias de prueba seleccionadas, el test 
automatico debería terminar mostrando la siguiente ventana: 
 

 
 
Haga click en “CONTINUE” para mantener el programa PC850 en la ventana; esto permite al 
usuario realizar pruebas adicionales si es necesario - por ejemplo, para repetir un umbral a 
una frecuencia determinada (ver Secciones 4.3.7 & 4.3.8). 
 
Haz click en “ACCEPT” para cerrar el software PC850 y transferir todos los umbrales 
automáticamente de nuevo a Audibase. 
 
Ver Sección 4.5 para hacer frente a los errores. 
 
Al transferir los umbrales para Audibase recuerde “save” (guardar) la información en 
Audibase para almacenarla en la base de datos (ver el manual de Audibase). Si la 
información no se va a guardar, utiliza “Edit > Cancel Insert/Edit” para descartarlo en el 
menu de Audibase, o haga clik en el botón cancel insert/edit de la barra de herramientas 

de Audibase   
 
Cuando los datos se guardan en Audibase, aparece una ventana de diálogo similar a la que se 
muestra abajo. Ésta muestra la categorización del nivel auditivo y da la oportunidad al 
operador para indicar cuando quiere volver a llamar al paciente. 
 

 
 
 
Introduce el periodo apropiado desde las opciones del menu desplegable y haz click en “OK” 
para confirmar que se guarden los datos. Al hacer clic en “Cancel" se cancelará la operación 
de guardar y desechar los datos. 
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Los usuarios han de saber que es posible modificar los resultados de pruebas audiométricas 
transferidos a Audibase, siempre y cuando no se hayan guardado. Ver el manual de Audibase 
para más detalles. 
 
4.3.4.2 Cambiar el tipo de prueba u otras opciones 
 
Si se requiere una prueba alternativa o hay que cambiar las opciones de configuración haga 
click en “No” que cerrará la ventana de diálogo y permitirá que se seleccionen opciones 
alternativas. Ver Secciones 4.3.5 a 4.3.9 y Sección 4.4, según lo que necesite, para 
información adicional. 
 
 
4.3.4.3 Prueba Función Talkover  
 
Si la tecla TALKOVER está pulsada mientras una prueba automatica está en proceso, dicha 
prueba se pausará y se mostrará una ventana de diálogo como la siguiente. 
 

 
 
Después de darle las instrucciones necesarias al paciente y liberar la tecla TALKOVER, el 
operador puede elegir para la prueba (“Abort”), volver a probar la frecuencia que se estaba 
utilizando cuando estaba presionada TALKOVER (“Retry”), o saltar la frecuencia que se 
estaba probando y pasar a la siguiente (“Ignore”). 
 
4.3.5 Prueba de ordenador (Computer)  
 
Utilice los controles del audiómetro para borrar cualquier lectura de las pruebas actuales 
(umbrales retenidos). Ver Sección 5.2.2. 
 
Haga click en el incono “Computer” (el icono se encenderá). 
 

 
 
Alternativamente use “Test > Computer” del menu despegable en la parte superior de la 
ventana del PC850 
 
Para ejecutar una prueba por ordenador (Computer), haga clic en el icono “Run selected test” 
 

 
 
y confirme la operación haciendo click en “Yes” en la ventana de diálogo Run Test 
 
La prueba por ordenador (Computer) se ejecutará de acuerdo a las opciones seleccionadas 
(ver Sección 4.4) con el estado de la prueba indicado en la parte inferior izquierda de la 
ventana de PC850. 
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En el modo ordenador (Computer) el tiempo disponible para que el paciente 
responda va desde que el tono se presenta hasta el comienzo del siguiente tono 
(aproximadamente 2.3 segundos como máximo). Si una respuesta se hace 
dentro de este periodo de tiempo, un retardo aleatorio se añade entonces a el 
tiempo hasta que se presenta el siguiente tono. 

 
La prueba procederá y concluirá como se describe en la Sección 4.3.4. Recuerde guardar 
(“save”) la información en Audibase para conservarla en la base de datos o “Cancel 
Insert/Edit” si la información se va a deshechar. (Ver el manual de Audibase). 
 
4.3.6 Prueba Bekesy  
 
Utilice los controles del audiómetro para borrar cualquier lectura de las pruebas actuales 
(umbrales retenidos). Ver Sección 5.2.2. 
 
Haz click en el icono de la prueba “Bekesy” test icon (el icono se encenderá) 
 

 
 
Alternativamente use “Test > Bekesy” del menu despegable en la parte superior de la ventana 
del PC850. 
 
Para ejecutar una prueba Bekesy haga click en el icono “Run selected test”. 
 

 
 
y confirme la operación hacienda clik en “Yes” en la ventana de diálogo Run Test. 
 
La prueba Bekesy se ejecutará de acuerdo a las opciones seleccionadas (ver Sección 4.4) con 
el estado de la prueba indicado en la parte inferior izquierda de la ventana de PC850. 

 
 
El tiempo disponible para que el paciente responda en el modo Bekesy va desde 
que el tono se presenta hasta el comienzo del siguiente tono 
  

 
La prueba procederá y concluirá como se describe en la Sección 4.3.4. Recuerde guardar 
(“save”) la información en Audibase para conservarla en la base de datos o “Cancel 
Insert/Edit” si la información se va a deshechar. (Ver el manual de Audibase). 
 
4.3.7 Prueba Frecuencia Única 
 
Esta opción permite una prueba automática a una única frecuencia que se repite, por ejemplo, 
si la prueba automática completa ha sido incapaz de grabar un umbral. 
 
Use “Test > One freq. test” del menu despegable en la parte superior de la ventana del PC850 
para seleccionar la frecuencia únicade las disponibles para la prueba. 
 
Se realizará una prueba automática a esa frecuencia y procederá y concluirá como se 
describe en la Sección 4.3.4. Recuerde guardar (“save”) la información en Audibase para 
conservarla en la base de datos o “Cancel Insert/Edit” si la información se va a deshechar. 
(Ver el manual de Audibase). 
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4.3.8 Prueba de modo Mixto 
 
Esto permite que las lecturas manuales se puedan insertar en las frecuencias en las que el 
test automatic no ha sido capaz de establecer el umbral. En estos casos el test automatico 
debería terminar mostrando la siguiente ventana: 
 

 
 
Haz click en “CONTINUE” y anota las frecuencias a las que los umbrales no se establecieron. 
 
NOTA: pulse “ACCEPT” sólo si desea salir del programa PC850 y transferir la prueba 
incompleta a Audibase. 
 
Vuelve al audiómetro y úsalo para determiner manualmente los umbrales a esas frecuencias 
(ver Sección 5). Será más fácil hacerlo si algún resultado mostrado (los “umbrales retenidos” – 
ver Sección 5.3) se han limpiado (ver Sección 5.2.2) 
 
Cuando los resultados de las pruebas manuales necesarios se han establecido en el 
audiómetro haga click en el icono “Select insert manual readings” (el icono se encenderá) 
 

 
 
Alternativamente use “Test > Mixed” del menu despegable en la parte superior de la ventana 
del PC850. 
 
Para transferir los umbrales conjuntos a Audibase haga click en el icono “Run selected test”.  
 

 
 
y confirme la operación haciendo click en “Yes” en la ventana de diálogo Run Test. Se 
muestra la siguiente pantalla de diálogo. 
 

 
 
En este caso, deje seleccionado “Current readings”, haga click en OK y la información 
conjunta se transferirá a Audibase cuando la ventana de PC850 se cerrará. Recuerde guardar 
(“save”) la información en Audibase para conservarla en la base de datos (Ver el manual de 
Audibase). 
 
Tenga en cuenta que los umbrales de las pruebas automáticas grabadas siempre se 
transferirán, incluso si el umbral se ha introducido manualmente en el audiómetro a esa 
frecuencia. Solamente los umbrales manuales que se introdujeron en las frecuencias donde 
no existe un umbral de prueba automática se transfieren a Audibase. 
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Tenga en cuenta también que si los resultados de las pruebas anteriores en el audiómetro (los 
“umbrales retenidos”) no se limpiaron, entonces cualquier umbral retenido a frecuencias donde 
el test automatico no se completó (p.e para frecuencias que se deseleccionaron en un test 
automático) se transferiría a Audibase. Esto ocurre porque es esencial limpiar los umbrales 
retenidos antes de llevar a cabo una prueba automatica. 
 
4.3.9 Prueba Manual  
 
Esto supone que un conjunto de umbrales audiométricos ya se ha establecido utilizando el 
audiómetro en modo de prueba manual (véase la Sección 5). 
 
Haga click en el icono “Select upload manual test” (el icono se encenderá). 
 

 
 
Alternativamente use “Test > Manual” del menu despegable en la parte superior de la ventana 
del PC850. 
 
Para transferir los umbrales conjuntos a Audibase haga click en el icono “Run selected test” 
 

 
 
y confirme la operación haciendo clik en “Yes” en la ventana de diálogo Run Test. Se muestra 
la siguiente pantalla de diálogo. 
 

 
 
Esto permite que cualquier de las lecturas actuales (“Current readings”) (p.e. los umbrales 
retenidos - ver Sección 5.3) o los umbrales almacenados en una de las memorias internas del 
audiómetro (ver Sección 5.4) para transferir a Audibase. Para seleccionar una ubicación de 
memoria interna desmarca la casilla de “Current readings” e introduce la ubicación de la 
memoria (númerous 1 a 12). 
 
Haga clik en OK y la información seleccionada se transferirá a Audibase cuando la ventana de 
PC850 se cerrará. Recuerde guardar (“save”) la información en Audibase para almacenarla en 
la base de datos (ver el manual de Audibase) 
 
Tenga en cuenta que el método de prueba manual descrito anteriormente transferirá sólo los 
umbrales almacenados en el audiómetro. Los resultados de cualquier prueba automática 
(parcial) se descartarán. Por lo tanto, si una prueba automática se ha completado pero con 
errors, el modo “Mixed Test” debería usarse para inserter lecturas manuales en la prueba 
automatic incomplete (ver Sección 4.3.8) 
 
4.4 Opciones para configurar y manejar una prueba automatic 
 

El menú “Options” en la parte superior de la ventana PC850 abre un cuadro de diálogo, que 
ofrece acceso a un número de opciones como se indica a continuación: 
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 Frequencies, permiten al operador añadir o eliminar frecuencias específicas a o desde el 
regimen de prueba; tenga en cuenta que 1 kHz está siempre incluido. 

 Computer test, que proporciona controles para permitir : 

 La selección de cualquiera de las 2 de cada 3 o 3 de cada 5 respuestas coherentes 
para generar un umbral válido. 

 Una familiarización antes de ejecutar la prueba. 

 Una re-prueba de la primera frecuencia que se omitió (incluir esta función puede ser 
útil en la correlación de los resultados de pruebas- ver también Sección 4.5.7) 

 Tone response, que establece controles para determinar la acción a tomar en caso de 
error: 

 El número de veces que se repite una frecuencia (0,1,2 o 3 veces) si se produce un 
error en la prueba (p.e, si el paciente no responde) 

 y cómo proceder si el error continua (salta la frecuencia, para la prueba o pausarla) 

 Patient details, puede ignorarse cuando se usa con Audibase 

 COM, puede ignorarse para instrumentos con números de serie incluidos en esta guía del 
usuario 

 Colour display, puede seleccionarse para mostrar el audiograma en color 

 Colour print, puede ignorarse cuando se usa con Audibase 

 Beep on finish, suena una señal acústica en el PC al final de la prueba 

 Password, permite que el usuario introduzca una contraseña válida para el audiómetro 
conectado 

 
4.5 Tratamiento de errores y solución de problemas 
 
4.5.1 Instrumento no conectado 
 
Si el audiómetro no se ha conectado cuando se elige una prueba de Audibase una ventana se 
abre similar a la que se muestra debajo. 
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Compruebe: 

 Que el audiómetro PC850 está encendido 

 Que el audiómetro PC850 está conectado al ordenador  

 Que el software del PC850 se ha instalado correctamente  
 
Pulse OK para cerrar la ventana y utilice la opción “Edit > Cancel Insert/Edit” para cancelar la 
operación. Las funciones de Audibase podrán continuar. 
 
4.5.2 Contraseña incorrecta (Wrong Password) 
 
Si aparece este mensaje, el audiómetro se está usando con una versión de Audibase más 
antigua que la Versión 5.5. Por favor, consulte la documentación suministrada con la versión 
anterior. 
 
4.5.3 No hay respuesta del paciente  
 
Si el paciente no pulsa el interruptor de respuesta y se ha alcanzado el nivel máximo de salida 
se mostrará la siguiente ventana: 
 

 
 
Compruebe: 

 Que los auriculares y el botón de respuesta estén enchufados correctamente 

 Que el audiómetro está presentando un tono 

 Que el pulsador de respuesta del paciente funciona correctamente  

 Que el paciente entiende la prueba y sabe cómo responder a los tonos presentados 
 
El operador puede elegir para la prueba (“Abort”), probar de nuevo la frecuencia (“Retry”) o 
saltar la frecuencia que se está probando y pasar a la siguiente (“Ignore”). 
 
4.5.4 Respuesta Continua del Paciente 
 
Si el paciente pulsa continuamente el interruptor de respuesta no sera possible grabar un 
umbral auditivo y se mostrará la siguiente ventana: 
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El operador puede elegir parar la prueba (“Abort”), probar de nuevo la frecuencia (“Retry”) o 
saltar la frecuencia que se está probando y pasar a la siguiente (“Ignore”). 
 
4.5.5 Sin resultados 
 
Si no hay resultados disponibles para trasnferir a Audibase se mostrará la siguiente ventana: 
 

 
 
Esto puede ser porque la ventana del PC850 se cerró antes de que se pudieran grabar los 
umbrales, la prueba se dió por ternminada o ocurrió algún otro problema con la secuencia de 
la prueba. Haga click en OK para cerrar la ventana y luego la opción “Edit > Cancel Insert/Edit” 
para cancelar la operación. Una prueba adicional puede entonces comenzarse desde 
Audibase. 
 
4.5.6 Errores en la secuencia de prueba 
 
Si uno o más umbrales no pueden grabarse aparecerá el siguiente cuadro de diálogo al final 
de la prueba. 
 

 
 
Haga click en “CONTINUE” para mantener el programa PC850 en la ventana; esto permite al 
usuario realizar pruebas adicionales. Tenga en cuenta las opciones descritas en las Secciones 
4.3.7 y 4.3.8 para completar la prueba. 
 
Haga click en “ACCEPT” para cerrar el software PC850 y transferir los datos incompletos para 
Audibase. 
 
4.5.7 Incoherencia en la prueba de repetición a 1kHz  
 
Si la opción de repetición de frecuencia está activada para una prueba de ordenador 
(Computer test - ver Sección 4.4) se llevará a cabo una prueba adicional al final y se 
comparará con el resultado de la prueba original a esta frecuencia. 
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Si los dos resultados difieren en 10 dB o menos, entonces el segundo resultado se registra 
como el umbral a 1kHz y la prueba continúa. 
 
Si los dos resultados difieren mas de 10 dB aparecerá la siguiente ventana. 
 

 
 
El operador puede elegir parar la prueba (“Abort”), probar de nuevo la frecuencia (“Retry”) o 
saltar la frecuencia de repetición y pasar a la siguiente (“Ignore”). Si selecciona la opción 
ignorer el Segundo resultado se grabará como el umbral a 1kHz. 
 
4.5.8 Cable USB desconectado  
 
Si el cable que conecta el PC850 al PC se desconecta cualquier prueba de funcionamiento 
automático cesará. El audiómetro puede tardar algunos segundos en detener la prueba. Es 
possible seleccionar los botones de control y las opciones de menu en la ventana de PC850 
en el ordenador, pero no tendrán ningún efecto. Vuelva a conectar el cable USB tampoco 
tendrá efecto. 
 
Dependiendo de la tarea que estaba en proceso cuando se produjo la desconexión, uno o más 
mensajes de error pueden aparecer, por ejemplo: 
 

 
 
Si es posible utilizar “File > Exit” del menu desplegable en la parte superior de la ventana del 
PC850. Esto debería cerrar la ventana y volver a Audibase. Pueden aparecer otros mensajes 
de error, por ejemplo: 
 

 
 
Si es posible, use la opción “Edit > Cancel Insert/Edit” en Audibase para descartar los datos, y 
luego cierre Audibase. 
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Dependiendo de la tarea en proceso cuando se produjo la desconexión, el audiómetro puede 
bloquearse y no responde a los controles. Si es possible, trate de apagar el audiómetro como 
se describe en la Sección 3.2. luego desenchufe el audiómetro unos segundos. Entonces el 
PC850 podrá volver a conectarse e iniciar Audibase normalmente. 
 
4.5.9 Cierre accidental del programa PC850  
 
Si el programa PC850 se cierra mientras está en marcha una prueba automatica, ésta 
terminará y aparecerá el mensaje “No results” en Audibase (ver Sección 4.5.5). Es necesario 
apagar el audiómetro y encenderlo (ver Sección 3.2). Borrar cualquier resultado y reinicie la 
prueba. 
 
5 Uso del audiómetro (pruebas manuales) 
 
La prueba manual con el audiómetro en el modo “standalone” se llevará a cabo con o sin 
conexion al ordenador. Si una prueba automática se ha puesto en marcha por Audibase, la 
prueba manual no es possible realizarla hasta que éste haya concluido. 
 
5.1 Pantalla del audiómetro 
 
Al iniciarse el aparato, la pantalla muestra las siguientes opciones por defecto: 
 
SIGNAL dBHL     FREQUENCY Hz 

 30dB                            1kHz 

 < >           < >       

 
Esto indica que al presionar el botón PRESENT se le presentará al oído indicado un tono de 
30dBHL a una frecuencia de 1kHz (1000Hz). Al iniciar la operación, el audiómetro selecciona 
por defecto el oído izquierdo.  
 
5.2 Controles del Audiómetro 
 
5.2.1 Teclas multifunción 
 
Varias teclas en el audiómetro tienen funciones diferentes dependiendo del modo de 
operación. Son: MENU (OFF), LEFT (NO), RIGHT (YES) y FREQUENCY   (MENU 
SELECT). Su uso se describe a continuación. 
 
5.2.2 MENU 
 
Apretar y mantener pulsado el botón de MENU para acceder a las opciones siguientes. Utilice 
las teclas MENU SELECT para desplazarse por las opciones disponibles y luego el NO, YES o 
SIGNAL con las teclas  para seleccionar una acción o modificar un ajuste. Suelte la tecla 
MENU para iniciar la acción o guardar la configuración modificada y volver a la pantalla 
principal. 
 

Opciones de menú  Descripción 
 
Switch off?:   (Desconectar) Como se describe en la Sección 3.1 

 
Clear test?: Presionar YES y soltar la tecla MENU para borrar los resultados 

mostrados 
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Save audiogram to (1): Use las teclas SIGNAL  para seleccionar la ubicación de 
almacenaje y presiones YES para guardar la información 
después suelte la tecla MENU 

 
Load audiogram no (1): Use las teclas SIGNAL  para seleccionar la ubicación de 

almacenaje y presiones YES para cargar la información después 
suelte la tecla MENU 

 
Contrast:  Ajustarlo usando las teclas SIGNAL  después suelte la tecla 

MENU 
 
5.2.3 Descripción de la función de otras teclas 
 

+20dB      Permite que los niveles de tono se presenten con una salida de hasta 
20dB superior; presione la tecla y luego utilice la tecla SIGNAL  para 
acceder a los 20dB adicionales; un indicador verde sobre la tecla 
muestra que la función está activa 

 
TALK OVER Interrumpe la prueba y envía la voz del operador del micrófono interno al 

auricular; el nivel puede ajustarse con las teclas SIGNAL  
 

LEFT Presionar para seleccionar auricular izquierdo, el indicador que está 
sobre la tecla se ilumina en verde; si el auricular izquierdo ya está 
seleccionado pulse de nuevo para almacenar el valor de la señal que se 
muestra como un umbral (ver Sección 5.3) 

 
RIGHT Presionar para seleccionar auricular derecho, el indicador que está 

sobre la tecla se ilumina en verde; si el auricular derecho ya está 
seleccionado pulse de nuevo para almacenar el valor de la señal que se 
muestra como un umbral (ver Sección 5.3) 

 
SIGNAL Presiona las teclas  para aumentar o disminuir el nivel de tono 

presentado en pasos de 5dB; para moverse a través de la gama de 
rangos mantener presionada la tecla 

 
FREQUENCY Presiona la tecla  para seleccionar una frecuencia más baja o la tecla 

 para aumentar la frecuencia 
 

PRESENT Presiona para mostrar la prueba al paciente; el indicador PRESENT 
situado sobre la pantalla se iluminará en verde durante la presentación 

 
5.3 Función de retención de umbral 
 
Esta función permite que los umbrales determinados para cada oído y cada frecuencia se 
almacenen y se muestren como referencia. 
 
El operador podrá entonces revisar los resultados al final de la prueba y grabarlos en una 
tarjeta de audiogramas, guardarlos en la memoria interna (ver Sección 5.4) o transferir los 
resultados a la base de datos Audibase (ver Secciones 4.3.9 o 5.6). 
 

Una vez que el umbral se ha fijado presiona la tecla del auricular seleccionado otra vez y el 
nivel se almacenará y se mostrará de una forma similar a la que se muestra abajo. 
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Para revisar los umbrales guardados, selecciona la frecuencia utilizando las teclas de 
FREQUENCY . Los valores almacenados para los auriculares izquierdo y derecho se 
muestran en la parte baja de la pantalla a la que se muestra abajo. 
 
SIGNAL dBHL          FREQUENCY Hz  

  30dB                         4kHz  

 20          10 

Esta imagen 
muestra umbrales 
a 4kHz 

 THRESHOLDS Oído izq. 20dBHL 
Oído der. 10dBHL 

  

Para borrar la memoria de retención de umbrales utilice la opción de menú “Clear test” 
descrita en la Sección 5.2.2. 
 
5.4 Guardar audiogramas en la memoria interna 
 
El usuario puede almacenar hasta 12 audiogramas, referenciados por medio de números, en 
la memoria interna del audiómetro. Para guardar el conjunto de umbrales actuales (los valores 
guardados descritos en la Sección 5.3) mantenga presionada la tecla MENU, presione MENU 
SELECT  repetidamente hasta que “Save Audiogram to 1” aparezca en la pantalla. Use 
SIGNAL  para seleccionar una localización numerada de 1-12, y entonces pulse YES. 
Suelte la tecla MENU una vez que aparezca la confirmación en la pantalla. 
 
Tenga en cuenta que el proceso Guardar sobrescribirá los registros que existen en la 
ubicación de memoria seleccionada. 
 
5.5 Cargar audiogramas desde la memoria interna 
 
Mantenga presionada la tecla MENU, presione MENU SELECT repetidamente hasta que 
“Load Audiogram no 1” aparezca en la pantalla. Use SIGNAL  para seleccionar una 
localización numerada de 1-12, y entonces pulse YES. Suelte la tecla MENU una vez que 
aparezca la confirmación en la pantalla. 
 
5.6 Transferencia de datos a la base de datos Audibase 
 
Ver el manual de funcionamiento de Audibase para transferir los resultados de las pruebas a 
un ordenador con el software Audibase de Amplivox instalado. 
 
5.7 Secuencia de la Operación y Procedimiento de prueba sugerido 
 
Las siguientes notas son de carácter orientativo. Consulte también la norma ISO 8253 para 
obtener más información. 
 
5.7.1 Antes de la prueba 
 
(1) Conecte los accesorios necesarios y encienda el audiómetro 
(2) Lleve a cabo una pre-prueba de sonido 
(3) Decida entre utilizar la función de umbral de retención y/o una tarjeta de audiograma para 

grabar los archivos obtenidos 
(4) Prepare el ambiente de prueba y al paciente (ver Secciones 3.4 to 3.6) 
(5) Si el interruptor de respuesta del paciente no se está usando, dé instrucciones al paciente 

para que reconozca cualquier tono presentado subiendo o bajando el dedo. 
(6) Si el interruptor de respuesta del paciente está en uso, dar instrucciones al paciente para 

reconocer cualquier tono presentado de la siguiente manera: 
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“Tan pronto como se oiga el sonido, presione el interruptor. Cuando ya no se escuche el 
tono debe soltar el interruptor.” 

 
(7) Ajuste los casco al paciente (ver Sección 3.6). Seleccione el oído con el que escucha mejor 

cada paciente presionando la tecla LEFT o RIGHT y comience con la session de 
familiarización. 

 
5.7.2 Familiarisación 
 
(1) Envíe el primer tono de prueba a 30dB a 1kHz durante 1 ó 2 segundos. Si el paciente no 

responde a 30dB, aumente el nivel de atenuación en pasos de 10dB hasta que el paciente 
responda 

(2) Cuando el paciente responda, espere durante 1 ó 2 segundos y presente el tono de nuevo 
al mismo nivel. Si el paciente responde a 30dB, reduce el nivel de la señal en pasos de 
10dB, repitiendo la presentación hasta que no haya respuesta, entonces incremente el 
nivel de la señal en pasos de 5dB hasta que el paciente responda; espera 1 ó 2 segundos 
y presente el tono de nuevo al mismo nivel 

(3) Si las respuestas son consistentes con el patrón de tono presentado proceda a la Sección 
5.7.3 y empiece a medir los umbrales de audición del paciente; si no es así, repita el 
proceso de familiarización 

 
5.7.3 Prueba 
 
(1) Use la opción Clear test (ver Sección 5.2.2) para borrar cualquier umbral 
(2) Envíe el primer tono de prueba a 30dB a 1kHz 
(3) Si el paciente responde, reduzca el nivel de la señal en rangos de 10 dB hasta el momento 

en que dejen de responder, posteriormente aumente el nivel de señal en rangos de 5dB 
hasta que el paciente responda 

(4) Si el paciente no escucha el primer tono, aumente el nivel de señal en rangos de 5dB hasta 
el momento en que responda y posteriormente continúe con el paso 5. 

(5) Repita la prueba reduciendo el nivel de señal en rangos de 10dB hasta que el paciente no 
responda, posteriormente aumente el nivel de señal en rangos de 5dB hasta el momento 
en que responda y verifique el nivel 

(6) Repetir el paso 5 hasta que el paciente responda tres de un máximo de cinco veces en el 
mismo nivel de señal, indicando el nivel de audición del paciente para dicha frecuencia. 
Cualquiera de los dos marque el umbral en una tarjeta de audiograma o presione la tecla 
apropiado una vez para activar la función de retención de umbral y guardar el nivel de 
umbral mostrando en la pantalla. (ver Sección 5.3) 

(7) Proceda a la siguiente prueba de frecuencia y repita los pasos 2 al 6. Es común realizar el 
test de frecuencias en el siguiente orden: 1k, 2k, 3k, 4k, 6k, 8k and 500 Hz. 

(8) Repita los pasos 2 a 7 para el otro oído 
 
5.7.4 Después de la prueba 
 
(1) Utilice la función de retención de umbral para ver los resultados (Ver 5.3) 
(2) En caso de ser necesario llevar a cabo uno o varios de los procedimientos siguientes: 
 
 Grabar los resultados en una tarjeta de audiograma, o 
 Grabar los resultados en la memoria interna (Sección 5.4), o 
 Transferir los resultados al ordenador (Secciones 4.3.9 o 5.6) 
 
Para borrar la memoria de retención de umbrales, utilice la opción del menú Clear test 
descripta en la Sección 5.2.2. 
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6 Especificación 
 
6.1 Datos de salida 
 
Salidas:     Auriculares izquierdo y derecho 
Rango de frecuencia (Hz):  250Hz-8kHz 
Precisión de frecuencia:  <1% 
Distorsión:    <2% 
Nivel de rango de salida:  -10dBHL mínimo; 100dBHL máximo (todas las frecuencias) 
Nivel de frecuencia de salida: dentro de los 3dB 
Tamaño del nivel de salida:      5dB 
Transductor de salida :  auriculares DD45 (suministrados)     
Tipo de tono:    Sencillo 
Comunicación:    “Talkover” (ver 5.2.3) 
Interface USB:    Al ordenador (software PC850 y Audibase) 
 
6.2 Datos físicos 
 
Pantalla: 2 líneas de 24 caracteres 
Unidad de poder: 100-240Vac; 50/60Hz; 0.4A 
Dimensiones: 270mm largo; 175mm profundidad; 68mm altura 
Peso: 750g 
Seguridad: IEC 60601-1 (mas UL, CSA & EN desviaciones) 
EMC: IEC 60601-1-2 
Marca CE: Hacia el EU utensilio Medico Directivo 
 
6.3 Clasificación del equipo 
 
Tipo de protección contra choque eléctrico: alimentado por una fuente de alimentación SELV 

clase II (por sus siglas en inglés: "Separated or Safety Extra-Low Voltage). 

 

Grado de protección contra choque eléctrico:  Parte aplicada Tipo B  

Grado de protección contra filtración de agua:  No está protegido 

Modo de operación:  Operación continua 

Movilidad del Equipo:  Portátil 

 
El Audiómetro PC850 está clasificado como aparato clase IIa según el Anexo IX del Directorio 
de Aparatos Médicos de EU. Su finalidad es servir como un audiómetro herramienta de 
detección. 
 
7 Simbología  
 

Los siguientes símbolos aparecen en el audiómetro o en el adaptador de corriente: 

 
 

Definición: Consulte el manual de instrucciones (obligatorio). 
 

 
 

Definición: Componente aplicado tipo B: un componente aplicado que da 
protección contra una descarga eléctrica, particularmente en relación a la 
corriente de fuga del paciente y a la corriente auxiliar del paciente. 

  

 



 

Página 24                                OM015-10 PC850 Manual de funcionamiento  

Los componentes aplicados son los auriculares izquierdo y derecho, el 
interruptor de respuesta del paciente y los cables correspondientes. 

 

Definición: La salida del adaptador principal AC es corriente directa. 
 
 

Definición: Equipo Clase II – -En este equipo la protección contra choque 
eléctrico no recae únicamente en el aislamiento básico, sino que tiene 
protecciones adicionales de seguridad tales como doble aislamiento o 
aislamiento reforzado (ya que no hay disposición de protección de puesta a tierra 
o dependiendo de las condiciones de instalación). 

 
8 Información Técnic 
 
Audiómetro 
Tipo de Audiómetro:    Tipo 4 (IEC 60645-1:2001) 

      Tipo 4 (ANSI S3.6:2004) 
 
Transductores 
Tipos y niveles de referencia:   DD45: ISO 389-1, Tabla 2 
Fuerza estática de la banda para la cabeza: Audífonos: 4.5N 
Características para atenuación de sonido: ISO8253-1, Tabla 3 
 
Características para atenuar el sonido de los audífonos 
 

Frequency, Hz 250 500 1000 2000 4000 8000 

Attenuation, dB 5 7 15 25 31 23 

 
Ambiente 
Temperatura de operación:   +15oC a +35oC 
Humedad de operación:    30% a 90% (sin condensación) 
Presión atmosférica:    700 hPa a 1060 hPa 
 
Entrada y salida 
Potencia de Alimentación:    2.5mm conector tipo barril. 
Entrada para la respuesta de paciente:  6.3mm conector tipo jack 
Salidas izquierda y derecha:    6.3mm enchufe tipo jack 
Inserción de salida:      Mono 3.5mm enchufe tipo jack 
USB:        Enchufe tipo B 
Voltaje máximo en cualquier salida:  12V pico 
 
9 Mantenimiento rutinario 
 
9.1 Mantenimiento del Audiómetro 
 
El audiómetro Amplivox PC850 es un instrumento de precisión. Se debe manejar con cuidado 
con el fin de asegurar su continua precisión y servicio. Para limpiar el aparato, primero debe 
desconectarse el suministro de corriente. Use un trapo y detergente suaves para limpiar el 
panel de instrumentos cuando sea necesario. Verificar ISO 8253-1 para mayor información. 
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9.2 Mantenimiento del Transductor 
 
Antes de utilizarlo verifique los cables y conectores del transductor para detectar indicios de 
desgaste y/o daños. En caso de encontrar alguno, por favor reemplace el artículo 
inmediatamente y contáctate con Amplivox o su distribuidor Amplivox, para solicitar el número 
de parte correspondiente (ver Sección 13). 
 
Use los auriculares del audiómetro y demás accesorios con precaución. Para las piezas que 
están en contacto directo con el paciente se recomienda utilizar partes de repuesto o que las 
piezas se desinfecten entre un paciente y otro. 
 
Lo anterior incluye tanto la limpieza física como el uso de un desinfectante efectivo. Se deben 
seguir específicamente las instrucciones del fabricante para el uso del agente desinfectante 
para limpiar apropiadamente las piezas. 
 
Limpiar los cojines de los auriculares incluyendo los de los Audiocups si se utilizan, con algún 
desinfectante. (Ejemplo “Mediswab”). 
 
 

Durante el proceso de limpieza cuide que la humedad no entre en el auricular o 
las rejillas del micrófono. 
 

 
9.3 Mantenimiento del alimentador de corriente 
 
Antes de utilizarlo verifique el adaptador de corriente alterna para detectar indicios de 
desgaste y/o daños. En caso de encontrar alguno, por favor reemplace el artículo de forma 
inmediata contactando con Amplivox o con su distribuidor Amplivox. Consulte la Sección 13 
para conocer los números de parte autorizados. 
 
 

No utlice ningún otro tipo de adaptador de corriente con este instrumento. 
Ver Sección 2.3. 
 

 

10 Guardado y transportación del aparato 
 
El aparato debe ser transportado o almacenado considerando los siguientes parámetros 
ambientales: 
 
Temperatura:    -20oC a +70oC 
Humedad:    10% a 90% (sin condensación) 
Presión Atmosférica:    500 hPa a 1060 hPa 
 
11 Reparación y calibración del instrumento 
 
Amplivox recomienda que este audiómetro sea calibrado cada año. Contacte a Amplivox o al 
distribuidor asignado para conocer los detalles del servicio de calibración. 
 
 

El instrumento debe ser reenviado al fabricante para servicio y reparación. 
No contiene partes que puedan ser reparadas o restauradas por el usuario. 
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Cuando embale el instrumento para su envío, utilice la caja de envío y los materiales de 
embalaje originales. Por favor asegúrese de que los cables del auricular no se envuelven 
alrededor de la cabeza de los auriculares. 
 
12 Garantía 
 
Todos los instrumentos de Amplivox están garantizados contra defectos materiales y de 
fabricación. El aparato se repara sin costo por periodo de dos años a partir de la fecha de 
devolución si es que se regresa, el servicio de envío corre a cargo del departamento de 
servicio de Amplivox. El reenvío del aparato corre por cuenta del cliente a menos que sea en 
Reino Unido. 
 
Nota importante: 
Excepciones: 
 
Los audífonos pueden requerir calibrarse debido a un brusco manejo o algún impacto del 
aparato. La vida de los cables también depende de las condiciones de uso. Estas piezas sólo 
están garantizadas contra defectos de materiales o fabricación. 
 
13 Pedir accesorios y consumibles 
 
Para solicitar consumibles y accesorios adicionales, reponer partes dañadas, y conocer los 
gastos de envío, contacte con su distribuidor Amplivox. A continuación se exponen los 
productos disponibles: 
 
No. de pieza  Descripción 
 
A022   Audiocups (audífonos reductores de ruido) 
AC1042  Audiocup cojín para el oído ear cushion 
AC1047  Audiocup banda para la cabeza 
AC1048   Funda de la vincha de los protectores auditivos de copa 
 
A023   Vincha (auricular estándar) 
A026   Cojín para audífonos 
A032   Auriculares DD45 * 
A030   Guía para set de cabeza Headset lead 
 
B128   Bolsa de transporte 
 
A091-7  Adaptador de corriente autorizado 
A085   Interruptor de respuesta para el paciente 
A051   Tarjetas de Audiograma (paquete de50) 
MANPC850  Manual operativo Amplivox PC850 (OM015) 
F07   USB Cable, 1.8m 
 

Los accesorios indicados con * deben ser calibrados con el audiómetro 
específico para ser utilizados. No intente utilizar estos accesorios hasta 
que el audiómetro haya sido calibrado considerando sus características. 
. 

 
El envío de la documentación llevará adjunto el número de referencia mencionado en la parte 
de arriba. Las imágenes de las partes junto al número de almacenamiento están disponibles 
en la web de Amplivox. (www.amplivox.ltd.uk). Las instrucciones se adjuntan a cada pieza. 
 

 

http://www.amplivox.ltd.uk/
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14 Información sobre la eliminación de residuos 
 

Amplivox Limited es totalmente compatible con el Reglamento de los RAEE 
(Residuos de Aparatos Eléctricos y Electrónicos). Nuestro PRN (Productor 
Número de Registro) es WEE/GA0116XU y están registradas en el Régimen 
aprobado WEEE, B2B, número de aprobación WEE/MP3338PT/SCH. 
 
El objetivo principal del Reglamento de RAEE (WEE) es fomentar la segregación 
de los elementos eléctricos de desecho de la corriente general de residuos y 
dirigirlos a la reutilización, valorización y reciclado. 
 

Cualquier unidad eléctrica desechable comprada a Amplivox que: 
 

 lleve el símbolo del contenedor de ruedas tachado con una barra negra debajo 

 O bien, haya sido reemplazada con nuevos productos Amplivox por otro similar 
 
Por favor, póngase en contacto con nuestro RAEE Compliance Scheme. El Cumplimiento B2B 
le proporcionará más información sobre cómo reciclar los residuos de las unidades eléctricas y 
responder a cualquier pregunta que pueda tener. 
 
B2B Compliance 
Tel: +44 (0) 1691 676 124 (Option 2) 
Email: operations@b2bcompliance.org.uk 

 

mailto:operations@b2bcompliance.org.uk
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Anexo 1 - EMC Declaraciones y guía del fabricante 
 

Guía y declaraciones del fabricante – emisiones electromagnéticas 

El audiómetro Amplivox PC850 se debe usar en el ambiente electromagnético especificado a continuación. El 
cliente o usuario del PC850 debe asegurarse de que se utilice en dicho ambiente. 

Prueba de emisiones Cumplimiento. 
Referencia de clasificación 

Guía del ambiente electromagnético 

Emisiones RF  
 
CISPR 11 

Grupo 1 El audiómetro PC850 usa energía RF sólo para sus 
funciones internas. Por lo tanto, sus emisiones RF 
son muy bajas y no deben causar interferencia en el 
equipo electrónico cercano a él. 

Emisiones RF 
 
CISPR 11 

Clase A El audiómetro PC850 es utilizado en 
establecimientos que no son de uso doméstico y que 
están conectados a la corriente de bajo voltaje para 
uso doméstico. Emisiones Armónicas 

 
IEC 61000-3-2 

Clase A 

Funciones de Voltaje 
emisiones oscilantes 
 
IEC 61000-3-3 

Cumple 

 

Declaración y guía del fabricante – inmunidad electromagnética (1) 

El Audiómetro Amplivox PC850 se debe usar en el ambiente electromagnético especificado a continuación. El 
cliente o usuario del PC850 debe asegurarse de que se utilice en dicho ambiente. 

Prueba de 
inmunidad 

IEC 60601 nivel de 
prueba 

Nivel de 
concordancia 

Guía de ambiente electromagnético 

Descarga 
Electrostática (ESD) 
 
IEC 61000-4-2 

±6 kV contacto 
 
±8 kV aire 

±6 kV contacto 
 
±8 kV aire 

Los pesos deben ser de madera, cerámica, 
concreto o azulejos. Si están cubiertos por 
algún material sintético la humedad relativa 
debe ser de por lo menos el 30% 

Rápida oscilación 
eléctrica 
momentánea/ 
estallido  
 
IEC 61000-4-4 

±2 kV para líneas de 
alimentación 
 
±1 kV para líneas de 
salida y entrada 

±2 kV para líneas 
de alimentación 
 
±1 kV para líneas 
de entrada y salida 

La calidad de corriente de alimentación 
principal debe ser la de ambiente típico 
comercial o de hospital  

Oleada 
 
IEC 61000-4-5 

±1 kV modo 
diferencial 
 
±2 kV modo común 

±1 kV modo 
diferencial 
 
±2 kV modo común 

La calidad de corriente de alimentación 
principal debe ser la de ambiente típico 
comercial o de hospital 

 

Prueba de 
inmunidad 

IEC 60601 nivel de 
prueba 

Nivel de 
concordancia 

Guía de ambiente electromagnético 

Bajas de Voltaje, 
interrupciones cortas 
y variaciones de 
voltaje en las líneas 
de corriente de 
alimentación de 
entrada  
 
IEC 61000-4-11 

<5% UT 
(>95% inclinación en 
UT) para ciclo de 0.5  
 
40% UT 
(60% inclinación en 
UT)para 5 ciclos 
 
70% UT 
(30% inclinación en 
UT) para 25 ciclos 
 
<5% UT 
(>95% inclinación en 
UT) para 5 seg 

<5% UT 
(>95% inclinación en 
UT) para ciclo de 0.5  
 
40% UT 
(60% inclinación en 
UT) para ciclos de 5  
 
70% UT 
(30% inclinación en 
UT) para ciclos de 25  
 
<5% UT 

(>95% inclinación en 
UT) para 5 seg 

La calidad de corriente de alimentación 
principal debe ser la de ambiente típico 
comercial o de hospital. Si el usuario del 
audiómetro PC850 requiere operación 
continua mientras hay interrupciones de 
corriente, se recomienda conectar el 
audiómetro PC850 a otra fuente de poder 
o colocarle pilas  

Frecuencia de poder 
de campo magnético 
(50/60 Hz)  
IEC 61000-4-8 

3 A/m 3 A/m La calidad de corriente de alimentación 
principal debe ser la de ambiente típico 
comercial o de hospital. 

NOTA UT es el a.c. voltaje principal antes de la aplicación de la prueba de nivel 
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Declaración y guía del fabricante – inmunidad electromagnética (2) 

El audiómetro Amplivox PC850 se debe usar en el ambiente electromagnético especificado a continuación. El 
cliente o usuario del audiómetro PC850 debe asegurarse de que se utilice en dicho ambiente.. 

Prueba de 
Inmunidad 

Nivel de 
prueba IEC 

60601 

Nivel de 
concordanci

a 

Guía de ambiente electromagnético 

 
 
 
 
 
 
 
RF Conducido 
IEC 61000-4-6 
 
 
RF radiado 
IEC 61000-4-3 

 
 
 
 
 
 
 
3 Vrms 
150kHz a 
80MHz 
 
3 V/m 
80MHz a 
2.5GHz 

 
 
 
 
 
 
 
3 Vrms 
 
 
 
3 V/m 
 
 
 

 

Los equipos móviles y portátiles no deben ser utilizados cerca de 
cualquier parte del audiómetro PC850, incluyendo cables, las 
distancias de separación recomendadas se calculan por la 
ecuación aplicable a la frecuencia del transmisor. 
 
Distancia de separación recomendada 
 
d = 1.2√P 
 
 
 
d = 1.2√P 80MHz a 800MHz 
 
d = 2.3√P 800MHz a 2.5GHz 
 
donde P es la potencia máxima de salida del transmisor en vatios 
(W) según el fabricante del transmisor y d es la distancia de 
separación recomendada en metros (m). 
 
 
 
 
 
Los campos de fuerza de un determinado Transmisor de radio 
frecuencia debe ser inferior que el nivel indicado para cada rango 
de frecuencia. 
 
Pueden ocurrir interferencias en la cercanía de equipamiento 
marcado con el siguiente símbolo: 
 
 
 
 
 
 

NOTA 1 A 80MHz y 800MHz, aplica la mayor frecuencia. 
NOTA 2 Estas reglas no se aplican a todas las situaciones. La propagación electromagnética se ve afectada por la 
absorción de estructuras, objetos y personas. 

a.- Los campos de fuerza de transmisores fijos, tales como estaciones base de radioteléfonos (móviles/ 
inalámbricos) y radios móviles terrestres, equipos de radioaficionados, AM y FM emisión de radio y emisoras de 
televisión no se pueden predecir teóricamente con precisión. Para evaluar el entorno electromagnético debido a 
transmisores de RF fijos, se debe realizar un estudio electromagnético. Si la intensidad del campo medida en el 
lugar en el que se utiliza el audiómetro PC850 supera el nivel de cumplimiento de RF aplicable anterior, el 
audiómetro PC850 se deberá observar para verificar su funcionamiento normal. Si se observa un funcionamiento 
anormal, será necesario tomar medidas adicionales, tales como la reorientación o reubicación del audiómetro. 
 
b.- Por encima del rango de frecuencia de 150 kHz a 80 MHz, las fortalezas de campo deben ser menores a 3 

V/m 
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Distancias de separación recomendadas entre los aparatos de RF portátil y el audiómetro PC850 

El audiómetro Amplivox PC850 está diseñado para usarse en un ambiente en el cual las radiaciones RF están 
controladas. El cliente o usuario del audiómetro PC850 pueden prevenir la interferencia electromagnética 
manteniendo una distancia mínima entre los equipos (transmisores) de comunicación RF móvil y el audiómetro 
PC850, de acuerdo al máximo voltaje de salida de cada equipo. 

Rangos máximos 
de salida de 

transmisores 
 

W 

Distancia de separación de acuerdo a la frecuencia del transmisor 
 

m 

150 kHz a 80 MHz 
 

d = 1.2√P 
 

80 MHz a 800 MHz 
 

d = 1.2√P 

800 MHz a 2.5 GHz 
 

d = 2.3√P 

0.01 0.12 0.12 0.23 

0.1 0.38 0.38 0.73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 

Para transmisores con una potencia de salida máxima no mencionados anteriormente, la distancia de separación 
recomendada puede ser calculada usando la ecuación aplicable a la frecuencia del transmisor en vatios (W) de 
acuerdo con el fabricante del transmisor. 
 
NOTA 1 A 80MHz y 800MHz, aplica la distancia de separación para los rangos de mayor frecuencia. 
 
NOTA 2 Estas guías no se aplican en todas las situaciones. La propagación electromagnética se ve afectada por la 
absorción y reflexión de estructuras, objetos y personas. 
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Anexo 2 – Uso con equipo eléctrico no-medico 
 
Cualquier persona que conecte equipos externos a la señal de entrada, la señal de salida y 
otros conectores crean un sistema eléctrico médico y por lo tanto es responsable de que el 
sistema cumpla con los requisitos de la cláusula 16 del IEC 60601-1:2005 (Requisitos 
generales para la seguridad básica y el funcionamiento esencial). 
 
Si se hacen conexiones de equipo estandarizado como impresoras y ordenadores, se debe 
tener una precaución especial para mantener la seguridad médica. Las siguientes notas sirven 
de orientación para realizar dichas conexiones, de modo que se asegure el cumplimiento de 
los requisitos generales de la cláusula 16 del IEC 60601-1:2005. 
 
Las siguientes señales de entrada y salida del audiómetro Amplivox PC850 están 
eléctricamente aisladas de acuerdo a los requerimientos de IEC 60601-1 con el fin de reducir 
cualquier riesgo asociado con el uso para encendido de las siguientes conexiones de entrada 
y salida: 

Etiqueta del 
enchufe 

Tipo de 
Conector 

Conexión Típica 

USB Conector USB  PC 

 
El equipo externo destinado para la conexión de salida y entrada u otras conexiones, debe 
cumplir con IEC o los estándares internacionales (por ejemplo IEC 60950, CISPR 22 & CISPR 
24 para equipo IT, y el serie IEC 60601 para equipo eléctrico médico).  
 
El equipo que no cumpla con IEC 60601 debe alejarse del paciente como se define en IEC 
60601-1 (por lo menos 1.5m del paciente). El operador debe evitar tocar el equipo que esté 
conectado y el paciente al mismo tiempo ya que puede causar daño. 
 
Por favor revise los diagramas 1 y 2 en la parte de abajo para las configuraciones más 
comunes del equipo periférico. Consulte Amplivox en la dirección indicada en la parte frontal 
de este manual del usuario si se requiere el asesoramiento sobre el uso de equipos 
periféricos. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Diagrama 1: PC850 (usado con suministro de corriente aprobado medicamente) 
 
 

 Toma de corriente   Adaptador médico 
 
 
 

 
  

 
 
 
 
 

 
 

    Audiómetro PC850 
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Diagrama 2: PC850 (usado con suministro de corriente aprobado medicamente y 
PC) 

 
 Toma de corriente         Adaptador médico 
 
 
 
 

 
  

 

 

    Audiómetro PC850 
 Toma de corriente 
 
 
 
 

 

 
 
 
 

 
 

 
 
 
 

PC Alimentador    PC Conector USB 

 
 

 

  

 

 

 


